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Electricimage™ 2.9 — What’s New

Electricilmage™ 2.9

Hello

Welcome to the CD Release of Electricmage 2.9. (This release is the follow-up to the Elec-
tricimage 2.9 Web Release. You do not need the Web Release to operate this version.) This
is the first major Electricimage software release since Electric Image, Inc. announced its
merger with Play Industries in April 1998. With it, we are excited to bring you some ter-
rific news! ElectricImage 2.9 represents the first integrated release since version 2.0 —
that’s right, Electricimage 2.9 recombines the Broadcast and Animation System versions

into a single, unified Electriclmage!

So, What’s New?
OK, you had to ask (we knew you would!) Here goes:

e Import and Convert Lightwave™ projects

* New Contextual menus

¢ New Lighting Options

¢ Phong Shading in All Views

* Shaded Texture Maps in All Views

¢ UV Texture Mapping

* New Texture Management tools

* New Texture Positioning tools

¢ View Surface Normals option

e Effectors now allowed in Bones hierarchies

e Limit Bones effects with Selection Sets

* Bone length changes automatically adjust hierarchy offsets

e Automatically Scaled Channels in Function Curve Editor

e Camera Projection Maps can be limited to surfaces visible to the projector only
e FACT models can be exported with zeroed values (FACT Snapshot)

...and of course, 2.9 renders even faster (in some cases, up to 15% faster!)
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Electricimage™ 2.9 — What’s New

We have also changed a few things:

* Negative Z now defaults to OFF

* Numerous Interface Improvements

¢ Improved Reliability

* Removal of the Still Camera Application (no longer necessary)

And, of course, the big news that you have all been waiting for — the ElectricIm-

age Modeler is included in this release!  We figure the Modeler alone should keep you
busy for awhile (it has sure kept us busy!) See the “Modeler Reference Manual” for all of
the Modeler scoop.

Lot’s of cool things are happening at Play! Be sure to check out Amorphium, our new, easy
to use 3D creation program. It’s really cool, and we know you will enjoy it (PC Week Mag-
azine called Amorphium “Best of Comdex for Digital Media” and Amorphium won “Best
of Show” at Macworld San Francisco! Amorphium also received 5 stars from ZDTV!)

The Trinity, Play’s television studio in a box, made its feature film debut in “ED TV” from
director Ron Howard. Trinity Globecaster lets you create a TV channel on the internet.
Gotta put your EI creations somewhere, right? Why not your own channel? (Look out,
Nightline!) Gizmos 98 is really burning up the sales charts and was even used to create its
own TV commercial! And Snappy continues to be the leader in PC Video Snapshots (of
course!) TV Technology Magazine calls Play the “undisputed leader...one of the most

aggressive, innovative and successful developers around.”

Electric Image, Inc. has been rechristened “Play Inc.—3D Group,” and has moved to hot
new digs in Irvine, CA (OK, so the address says Santa Ana, but it really is Irvine /Santa
Ana/Costa Mesa.) It's a beautiful building near John Wayne Airport, and just a stones
throw from “the most expensive mall in the world,” South Coast Plaza!

This is just a hint of what is to come from Play — keep your eyes wide open — we’re not
finished yet!
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Electricimage™ 2.9 — Installing Electricimage 2.9

Installing Electricimage 2.9

This web-based release contains only the files that have been updated since 2.8 first
shipped. Broadcast users will need to remove the old Camera, Still Camera, and Electric-
Image applications and replace them with the Camera and ElectricImage contained in this
archive. Animation System users will need to remove the old Camera and Electricimage

applications and use the Camera and ElectricImage contained in this archive.
As there is now just a single version ElectricImage, Still Camera is no longer required.

EI Resources Folder

A new EI Resources folder is created when you launch ElectricImage, and is placed in the
ElectricImage directory. Please do not remove or relocate this folder or the files contained
within it, as ElectricImage will not be able to operate without it.

EI Resource Folder implications for Network Rendering

If you use the network rendering features of ElectricImage, a copy of this folder and its
contents must be present on the slave machine, in the same directory that you have
installed Slave Camera. If the EI Resources folder is missing, a “Missing Resources” mes-

sage will be given.
Key files located in the EI Resources folder contain user specific information, utilizing
your hardware key, and can be copied to different machines. This saves you from entering

your codes again when you move your hardware key to a different computer.

New Security Procedures

We have simplified your security code entry process down to a single 8-digit code. This

will get you up and running faster, and make things much easier for us!
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Lightwave Scene Import and Conversion — Overview

Lightwave Scene Import and Conversion

ElectricImage 2.9 can import and convert Lightwave project files, saving them as Electricl-
mage project files. Use this feature primarily to migrate from Lightwave to ElectricImage,
and retain your model and texture map libraries. The differences between ElectricImage

and Lightwave are vast and expansive. Try as we might to make the importer as complete

as possible, there are several Lightwave features which are not currently supported.
Lightwave features not supported are:

e Ray Tracing (and ray traced shadows)
¢ Certain Surfacing attributes

¢ Certain Animation attributes

¢ Certain Rendering attributes

e Object Morphing

e MetaNurbs

* Hypervoxels

e Third Party Plug-ins

* Newtek Plug-ins

While we have endeavored to make the importation of Lightwave projects seamless, you
may find that certain settings have different results in Electricimage than they would in
Lightwave. This occurs when the differences are either historic, and would place too
much of an imposition on our users, or exist for technical reasons. Please email any differ-
ences that you find to us at techsupport@electricimage.com so that we may better doc-

ument the differences in the future.
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Lightwave Scene Import and Conversion — Importing Issues

So, What Comes In?

Just about everything not listed above will import properly. Virtually all of your anima-
tion channels should come in. Your hierarchies should be intact (although Lightwave sur-
faces will be added to the hierarchy list — see the following section) along with most of

your materials settings. Even texture maps are automatically converted!

Electricimage 2.9 offers most of the procedural shaders offered by Lightwave version 5.5.
In fact, the typical Electricmage version of the shader is anti-aliased (although not all of
them, as explained in the Version 2.8 Supplement). All of the ElectricImage procedural
shaders render much faster than their Lightwave equivalents.

Once you start working with Lightwave projects inside of Electricimage, you will notice
that ElectricImage often renders as much as 12 to 15 times faster. One reason for this is that
our default anti-aliasing is equivalent to Lightwave’s “enhanced high” mode. If you com-
pare Lightwave’s default anti-aliasing to ours, the difference is about 4 times (although
the ElectricImage anti-aliasing looks much better.) In addition, motion blur in ElectricIm-

age is far faster, and superior in appearance.

Beware of the Gotchas

The Lightwave Project Import feature works both with Macintosh and PC Lightwave
project files. There are some particular quirks when dealing with PC Lightwave files, hav-
ing to do with the length of file names, which the Macintosh version of Lightwave also

experiences.

PC/NT Filenames

Windows NT 4.0 and greater allow for filenames to be longer than 31 characters, while
Mac OS 8.5 and earlier does not. When PC files are brought to the Mag, either via a net-
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Lightwave Scene Import and Conversion — Importing Issues

work or CD-ROM,, filenames are shrunk down to 31 characters using an interesting (and
virtually unreproducable) scheme developed by Microsoft. Sparing you the scary details,
suffice it to say that long filenames referenced in the Lightwave Project can be different
than the actual files read by the Mac operating system (and, hence, Electricimage.)

If the files are not found, ElectricImage will notify you, and give you the opportunity to
relocate the files yourself. This can be very tedious if you have complex Lightwave
projects that contain many files with names that are 32 characters or longer (including the
“xxx" file extension.) Keep the filenames in your PC Lightwave projects to 31 charac-
ters or less (including the “.xxx” extension) to avoid the headache !

Groups vs. Surfaces

ElectricImage object files can contain “sub-objects” called groups. These groups form the
basis of animation hierarchies. For example, a model of a room might contain walls and a
door group. You can choose to animate the door separately, or parent the door to the

walls, forming a hierarchy. Groups can also contain numerous shading attributes, shaders

and texture maps for rendering.

In Lightwave, hierarchies are created by separate object files. A single object file cannot
contain any sub-objects which can be used for animation. Using the room example above,
you would have to supply separate model files for both the door and walls, should you

want to animate the door opening.

To impart shading information, Lightwave objects can contain user-defined “surfaces” in
which shading and texture map information are later applied. The Lightwave project file
acts as the container for both the hierarchical relationships of the model files, and for the

shading information of the model files.
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Lightwave Scene Import and Conversion — Material and Texture Differences

ElectricImage 2.9 will treat Lightwave object surfaces as if they were groups. These sur-
faces will appear as groups in the project window. Lightwave projects with many surfaces
will take some time to import, and the converted ElectricImage project that results will
also take time to read into the program. This is normal.

A Note About Texture Map Differences between Electricimage and Light-
wave

Unlike ElectricImage, Lightwave hasn’t made much use of 32 bit image files (files which
include an alpha channel.) Instead, Lightwave has chosen to require users to specify the
alpha, or mask, as a separate file. Electricimage simplifies the process by properly recog-
nizing and using 32 bit files.

To rectify this difference between the two applications, every time Electricimage detects
that a mask file is assigned to an image file in an imported Lightwave project, it merges
the image file and mask files together into a single, new 32 bit IMAGE file. When this pro-
cess is not required, the original file (and file type, if possible) will be used. Don’t worry
though, all of the projection and attribute information will be saved and applied to the
hybrid file. You can thank us later.

Lightwave Material and Texture Attributes in ElectricIlmage

With the introduction of ElectricImage 2.8, a new material channel paradigm was adapted
(covered in the Electricimage 2.8 Addendum.) This paradigm uses channels for each shad-
ing component, and each channel can have an unlimited amount of texture maps and pro-
cedural shaders. When importing Lightwave projects into Electricimage, textures are

assigned to their analogous Electricmage channels. A transparent texture in Lightwave is
placed in the appropriate transparent channel in Electriclmage, for example. In most

channels, Lightwave only allows values (equivalent to gray scales) whereas Electricimage
can often accept color information as well. In this version, Electricimage has added “Pho-
toshop®-style blend effects for each texture in a channel. Please see for more information.
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Lightwave Scene Import and Conversion — Import Process

Importing Lightwave project files into Electricimage

Electriclmage will use the same directory structure used by Lightwave to locate all of the
files in the project. It is important that you maintain this structure. To set up the desired
directory structure in Electricimage, do the following:

e Choose Edit>Preferences

e Select the Import & Data tab

e Select the Lightwave sub-tab

e Click on the Content Directory button

e Afile dialog will appear. Open the appropriate directory (typically “Newtek”)
*  Click on the Select button

You are now ready to import Lightwave projects. You can alternatively create project fold-
ers which will also work well when importing (using the project Blade.lws as our exam-
ple):

5] Jbiade oy DH

3 by, 429 5 FH wuinh b

| Bede e
¥ 1) It
b T Dtmila |

Figure 1 — Suggestion for Lightwave project directory structure

To bring your Lightwave files into ElectricImage, use the following steps.

e Choose File>Open
e Select the desired Lightwave Project
e (Click the Open button (or double click the project name)

® Choose an ElectricImage project name
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Lightwave Scene Import and Conversion — Import Process

Electriclmage will then automatically load and convert all of the files in the project.
Depending upon the size of the project, it might take a few minutes, so be patient. Elec-
tricimage will inform you of what it is doing every step of the way.

That's it. As you can see, importing Lightwave projects into ElectricImage 2.9 is pretty
painless. Enjoy!
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New Interface Features — Propagating Group Attributes

New Interface Features

Okay, so how could we let another version go by without adding a few new things to the
interface?? That's pretty tough to do, natch, and we can never resist an opportunity to
make things better. Here is a brief list of interface improvements to ElectricImage 2.9:

¢ Copying and Propagating Group Attributes

¢ Invert Glow and Fog

¢ View Drawing Modes (OK, so they were in 2.8, but we are documenting them here.)
*  Motion Path Improvements

* Bones Hierarchies

¢ Function Curve Editor Improvements

¢ (Camera Projection Map Improvements

e FACT Export Snapshot

* User preference additions

* Rendering Engine Improvements

Copying and Propagating Group Attributes (Contextual Menus)

In previous versions of Electriclmage, you copy settings from pulldown menus and check
boxes from one object to many or all other objects. This was accomplished by holding the
control or control-option keys while selecting the desired option.

This system has been replaced by a contextual menu. Hold down the control key while
clicking the checkbox or pulldown menu AFTER you have made the setting. This will
bring up a contextual menu that will allow you to copy the setting to the following

choices:
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New Interface Features — Invert Glow and Fog

e Al

¢ Remaining
e Children

e Offspring
* Visible

e Objects with a certain label
* Objects in a selection set

Invert Glow and Fog

Using this feature, you can now invert your lightrays and other glow and fog light effects.
For example, instead of your cool new logo casting shadows within your lightbeam, you
can have the cool new logo actually cast the lightbeam. Trés chic!

This feature is found in the Light Info Window/glow (and fog) tab.  To use it, just click
in the checkbox.

View Drawing Modes

ElectricImage 2.9 expands upon the shaded interface views of earlier releases by adding
very fast phong shading and texture map drawing in all windows on demand. As you
might imagine, some of these new display features can consume more time and memory.

Most often, though, they can significantly improve animation choreography.

You can access the window drawing modes by option-clicking on the blue ball located on
the bottom window frame of each world or camera window (the ball is located on the top

frame of other special windows, such as the texture view in the texture info window.)

BTE Ll

Figure 2 — Typical Window Frame Bottom, showing Blue Ball control
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New Interface Features — View Drawing Modes

When you activate this control with the option key, the following menus are presented,

depending upon the type of window that you are in at the time:
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Figure 3 — Window Display mode pop-up menus

The menu that you see depends upon where you have chosen to activate the menu, as

each window or view can have its own separate drawing mode. The explanation for these

modes are identical, and thus we will concentrate the discussion primarily to the menu on

the right of the illustration, the Texture Window drawing mode.

There are several choices listed in the Window Display menu. Each of these choices offers

their own benefits and detriments, and are discussed in detail on the following pages:

e Extent
e Point
e  Qutline

e Wireframe

e Point Shaded

e Outline Shaded

e  Wireframe Shaded
e Flat Shaded

¢ Gouraud Shaded
¢ Phong Shaded
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New Interface Features — View Drawing Modes

Extent

Selecting this mode draws the historically familiar cubic extent for each group. This is the
fastest setting, but offers the least in feedback.

Point

This mode draws points for each corner of every polygon in the scene. It can give you a
fast volumetric feedback, but is almost as abstract as the Extent mode.

Outline

This mode draws a “cartoon-style” outline for each group in the scene, including silhou-
ettes and contours. It offers more clarity than wireframe drawing, and is much faster, as it
has to draw much less. Outline mode provides very good feedback and response time.
Wireframe

This traditional mode draws all of the polygons in the scene as wires that you can see
through. This is the most clichéd drawing mode ever used in computer graphics. It is also

slow when large numbers of polygons are present in the scene.

Point Shaded

This mode is the same as the point mode, except that the points are shaded by the lights
within the scene. This mode can actually provide a combination of good speed and good
feedback, as the shading of the points can remove the abstract curse of Point only draw-

ing.

Outline Shaded

This mode is the same as Outline mode, except that the outlines are shaded by the lights
within the scene. It is tempting to use this mode, but if you have objects with complex
geometries, it can start to bog down when shading. You might find that you prefer Outline

mode overall.
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New Interface Features — View Drawing Modes

Wireframe Shaded

This mode is the same as Wireframe mode, except that the wireframes are shaded by the
lights within the scene. It is very sexy to look at, but there is a time penalty to shade all of

those wires.

Flat Shaded

This mode will shade each polygon in the scene giving a faceted or jeweled appearance. It
is a very fast shading mode, but does not adequately show spotlights, highlights, or tex-

ture maps.

Gouraud Shaded

This mode will smooth shade across each polygon in the scene, although spotlights and
highlights will not look as good as they do when the Phong Shaded mode is active. Tex-
ture Maps will be visible when this mode is on, and the Display Textures option is set in
the group info window, on an object-by-object basis.

Phong Shaded

This mode is the superior shading method, and the results will match the results when
you are rendering with the Electricmage rendering engine, Camera. Spotlights, highlights
and texture maps will all display correctly. To view textures require that the Display
Textures option is set in the group info window

In addition to the main options listed in the Window Display Mode menu, there are two

additional sub menus: Interaction and Options.

Interaction Sub Menu (Texture Window)

The Interaction sub menu allows you to fine tune the performance of the interface draw-

ing engine for maximum results and throughput.
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New Interface Features — View Drawing Modes

Update Time...

Full Fanty
o Drop Data
Crrop Quality

Figure 4 — Interaction Sub Menu (Texture Window)

There are four items in the Interaction Sub Menu:

e Update Time...
e Full Monty

¢ Drop Data

*  Drop Quality

Update Time...

This option brings forth a dialog which will allow you to set the amount of time that the
Drop Data and Drop Quality modes use as their threshold values.

Full Monty

This mode will draw everything, regardless of the setting found in the Update Time value.
Hey, what you see is what you get.

Drop Data

This mode will skip parts of the object in order to keep up with your interaction with the
program. Depending on the speed of your computer, you may not notice this too much.

Drop Quality

This mode will continue to drop the drawing quality of the model, until it can keep up
with you. This mode can be somewhat disconcerting to start with, but you get used to it.
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New Interface Features — View Drawing Modes

Options Sub Menu (Texture Window)
The options sub menu allows you to select aides which can help in the application of your

texture maps.

W Cull back faces
o Use lights
Show Morrals
Texture Shading

Figure 5 — Options Sub Menu (Texture Wlndow)

There are four items listed in the Options sub menu:

e Cull Back Faces
e Use Lights

¢ Show Normals
e Texture Shading

Cull Back Faces

This mode will speed up drawing by as much as two times, as the polygons which do not

face the viewer are removed (“culled”.)

Use Lights

This mode is active only when the Shaded options are selected. This mode allows you to

view the texture with normal scene lighting.

Show Normals

This mode will draw lines along the direction that each polygon is pointing. If there is a
problem with the normals of a particular polygon, it will be evident when examined with
this feature, and appear as a normal pointing in a direction opposite that of the neighbor-
ing polygons.
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New Interface Features — Motion Path Improvements

Texture Shading

The default presentation of the texture map on the surface of the model is “fully lit,” as if
you were viewing the texture in a paint program. The default method can hide detail at
times, so we created this option for you to use when you need to see some surface defini-

tion when you are applying your texture map.

In addition to the items covered in the Texture Window version of these menus, there are
three other options that are found in the World and Camera View versions of these menus.
These options are:

¢ Display None
e Display Lights
¢ Display Paths

Display None

This mode will draw nothing in the view. Hey, you never know.

Display Lights

This mode will draw the lights in the view. You can turn off the lights to hide the clutter, or

speed up the shading performance of the view.

Display Paths
This option will toggle the display of motion paths in the view.

Motion Path Improvements

Frame locations are now drawn on each motion path in the scene. This user-request will

help you to better see where you are, and where you are going. If only life were as easy.
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New Interface Features — Bones Hierarchies

Bones Hierarchies

Have you ever needed an effector in your bones hierarchy, only to be frustrated because
the program prevented you from doing that? Well, no longer. Bones deformations have
now been enhanced by allowing effectors to be included in bones hierarchies.

One of the ensuing frustrations with Bones-style deformations is that they are area-based,
and can affect groups that you didn’t intend to be affected. Now, you can use selection sets
(see Electriclmage 2.8 Supplement, page 135 for more information) to limit the effects
of bones to include or exclude certain groups, just as light inclusion/exclusion lists work.

To Add a Selection Set to a Bone:

¢ Create your selection set as desired

e Activate the Bone Info Window (ElectricImage 2.8 Supplement, page 396)

¢ Choose the new Bone Action tab

e Add the selection set

¢ Determine what behavior you need (to include or exclude members of the set)

Now, all of the members of the selection set will either be affected or ignore the bone,
depending upon the choice you have made.

This feature is especially helpful when you are using bones to create characters. In previ-
ous versions, if you had one bones deformation region move into another, the other region
would be affected. Now you can limit the effects of bones very specifically.

Note that you must specify a selection set for every bone that you wish to limit in

this fashion.

Also new to ElectricImage 2.9 is a change in the behavior of bone length scaling. Previ-
ously you had to manually adjust the length of each bone if you needed to make any
changes to the bones skeleton. ElectricImage 2.9 has rectified this, and now changing the
bone length automatically changes the offset of the next bone down in the hierarchy.
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New Interface Features — Function Curve Editor

Function Curve Editor

This feature has received great raves over the last year, and ElectricImage is proud to be
the only program in its class to offer such control. OK, enough patting ourselves on the
back — we're glad you like it.

Of course, it can always be made better, so we have added the following:

e Automatic Channel Scaling

¢ Interactive View Scaling

Automatic Channel Scaling

In previous versions of Electricimage, when you added channels to the Function Curve
Editor, you had to manually adjust the panning controls to see the selected curve.
(Because of the differences in values, curves for different channels can be in drastically dif-
ferent positions on the graph.) Now, selecting a channel in the editor causes the curve to
be placed within the center of the graph window (note that view scale is unchanged.)

This feature can be disabled using the Automatically Scale Graph preference, as
described in the Preferences section that follows.

Interactive View Scaling

You can interactively scale the graph window of the function curve editor by clicking on
any zoom icon, and then dragging. The direction that you drag will affect the zoom.
Remember that there are two zoom factors for the graph editor (time and value) which
can be independently controlled. Work with this for a couple of minutes to get the hang of
it. You'll love it.
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New Interface Features — Export FACT Snapshot

Camera Projection Maps

Have you ever wished that Camera projection maps worked more like real world slide
projectors, in that the map would only be visible on faces that were in the projector’s line
of site? You know, so that you could combine multiple camera projection maps from dif-

ferent angles onto the same geometry? Well, now you can.

The Special tab for each Camera Projection map now contains a new checkbox, Map Visi-
ble Surface Only. When this is turned on, a shadow buffer will be calculated for the map
and used to prevent the projection from penetrating the geometry to which it is applied.
This means that the Camera map will appear on the front surface (surface facing the pro-

jecting camera) only.

This feature is valuable in that it lets you easily determine which parts of the scene require
additional maps. Without this feature, the projected maps penetrate geometry and tend to
fill hidden parts of the scene with unwanted and confusing imagery.

There are also options to set the shadow buffer resolution and to calculate the buffer only

once during the animation.

Export FACT Snapshot

The FACT Snapshot feature will export a FACT file at the exact time the project is set to, in
whatever state the file is in at the time. In addition, this feature will “zero out” all of the

position and rotation attributes, and make the scale values 1.0.

Preferences

Some new preferences have been added to Electricimage 2.9. These preferences are
described by their containing tabs, below.
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New Interface Features — Rendering Improvements

Keyframe tab

Keypath Editor > Automatically Scale Graph.  This option causes the F-Curve editor to
fit the selected curve into the graph window.

Channel Type> these options are the default (implicit/explicit) settings for new objects.

Drawing, Preview & Render, Import & Data (Group)
The Display Mode/Detail/Draw Geometry Pull Down Menus: ~ pulldown menus now
allow you to set the default drawing level to Phong.

Import & Data tab

Group tab > Display Texture checkbox.  This controls whether or not new groups auto-

matically show their textures in the 3D views.

Group tab > Use UV Space . This controls whether or not new groups automatically use

their texture vertices for mapping.

Texture tab > Tiling. This sets the default tiling settings (mirror, repeat, hold, or none)

for new groups.

Socket tab > DisplayList Cache: pulldown . This option allows you to store the infor-
mation generated by plug-ins in memory (faster but takes more RAM) or on the disk
(slower but takes less RAM). This is a global setting and affects all plug-ins in the project.

Import & Data tab>Lightwave. This option allows you to control the import process
when reading in Lightwave project files. Each item represents how (or if) certain attributes
will be handled.

Rendering Engine Improvements (Camera)

As always, Camera just keeps getting faster and faster. For version 2.9, Camera is now up
to 15% faster than in previous versions. A project which took 2:22 per frame to render in

version 2.7.5 now only takes 1:20 per frame in Electricimage 2.9. As you can imagine, from
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time to time we develop a list of points to help Camera render even faster. We have listed
these below:

* Turn off as many extensions as you can.

* Run the Camera Application only when rendering

e Disable the Remember Recently Used Items for the Apple Menu.

e Turn off file sharing.

¢ In the Date & Time Control Panel turn off the Menu Bar Clock.

e FileI/O tends to be slow on the Mac. Consider using a striped disk drive array for
more speed.

We have seen the first five techniques nearly double rendering performance in many
cases!

And, last but not least, Camera properly handles light rays when the shadow buffer isn’t
square.
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New Texture Mapping Features

A variety of new texture mapping features have been implemented in Electricmage 2.9.
These features will significantly enhance the texture mapping and procedural shader
capabilities of ElectricImage.

Adobe Photoshop®-style Blend Mode feature added
¢ Texture Falloff effects added

* Texture Map Display in User Interface

¢ Texture Navigation Button in Texture Info Window
e New Cylindrical and Spherical Alignment Options
e Enhanced “Negative Z” feature

e UV Texture and Shading Coordinates

Blend Mode Menu

The Blend Mode menu in the Filter tab of the Texture Info Window allows you to better
control how texture maps and shaders affect what is beneath them as they are rendered. If
a single map is applied, then the mode selection will affect how the map is applied to the
surface of the group itself. If the texture or shader is applied on top of another map or
shader, then the blend mode selection you make will affect just that item directly under-
neath it. The blend mode functions in the same manner as blend mode for layers in Photo-

shop work with each other.
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Figure 6 — Texture Info Window Filter Tab with Blend Mode Menu

Blend Modes can be used only on images which contain data in the color channel of the
image maps (that includes gray scale images.) They cannot be used for the alpha channels
of an image map.

There are a total of 17 options in the Blend Mode menu. To assist in the understanding of
these functions, we have named them the same as their Photoshop counterparts. Please
refer to the Adobe Photoshop User Guide for an in-depth discussion of Blend Modes.

Blend Mode selection is important when you are reading project files from previous
versions of Electriclmage, including the Web Release of ElectricIlmage 2.9. To insure
the same results, each map should be set to “Multiply.”
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Figure 7 — Blend Mode Menu

In addition to the Blend Mode menu, two buttons have been added, which replace the 2.8
buttons called “By Color” and “By Value.” These buttons are “Use as Value” and “Invert.”

D Use &= Value

D Inwert

Figure 8 — New Map Control Buttons

These buttons are used to further determine how the map or shader will be used in the
channel in which it is applied. “Use as Value” will convert the color into greyscale values
for use with the blend modes. This option is used for creating typical diffuse, luminance,

transparency maps, and so on. The “Invert” button will swap the values of the map.

Texture Falloff

Texture falloff allows a texture to “fade away” towards the edges of a group by a user con-
trolled amount. This will allow you to cause the detail of a texture to blend away over a
distance, or for pseudo-color ramps to be easily created (ramping from the falloff texture

to the surface attribute underneath.)
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The texture will always falloff from the center of the group outwards, in all directions. The
falloff values presented are in actual object units. As an example, if a plane object is 200 by
200 units, and you wish your texture to falloff at the edges, you would type in 100 for all
three texture axes (remember to divide the size of the group in half, as falloff is calculated
from the center of the object.)

Falloff

Figure 9 — Texture Map Falloff Edit Boxes

You can control the falloff for each texture axis separately, allow for some interesting
effects. In a sense, texture falloff works like a quickie alpha edge mask.

Texture Map Display in User Interface

You can display phong shaded texture maps as they are applied to objects in any view
window in the project, which lessens the need for preview rendering. From a performance
standpoint, it is not possible to show all of the maps that an object can contain, as Electricl-
mage places no limits on the amount of maps an object can have. Therefore, Electricimage
will use the first map in the group’s diffuse list as the map that is drawn. Should no dif-
fuse map be present for a particular object, then the first map in the illumination list will

be used instead.
In order to minimize the impact on RAM, a small proxy of the texture map to be used is

created and applied, so your map will appear in a lower resolution. Don't worry, the map
will render correctly.

ElectricImage 2.9 Supplement




New Texture Mapping Features — Texture Info Window Additions

To enable texture display in Electricimage, follow these steps:

e Activate the Group Info Window
*  Choose the Display Tab
* Click on Display Texture

Textures will now be displayed for this object, if the appropriate shaded view modes are
selected.

To quickly enable other objects to display their textures, try this short cut after performing
the above steps:

¢ Control Click on Display Texture
*  Choose one of the options desired

Now, all objects which fit the criteria will be updated to your display choices.

Again, be mindful that if you have many objects, each with textures, you are going
to be adding significantly to the RAM requirements for Electriclmage.

Texture Navigation and Placement

In ElectricImage 2.8, the ability for any group to have an unlimited amount of textures
greatly expanded your creative abilities. Unfortunately, getting to all of those textures in
2.8 was a little tough sometimes. That’s been made much easier in Electricimage 2.9.

A new button has been added to help you move from texture to texture. Clicking on this
button will bring up a hierarchical menu that allows you to switch the Texture Info win-

dow to point at any texture on the current model.
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e

Figure 10 — Texture Navigation Button

This button is located above the tabs in the Texture Info Window, next to the map align-
ment buttons. You can get back to the Material Info Window by option-clicking on this

button.

The Fit to Selected button (Electricmage 2.8 Supplement, page 181 ) now has a pull-
down menu that is brought up by clicking the button with the option-key held down. The
choices are:

e Align to South Pole
e Align to North Pole
¢ Align to Equator Front
¢ Align to Equator Seam

These options are designed to assist you when positioning cylindrical and spherical maps.

Note that the button must be active in order for these options to be effective.

Align to South Pole
Choosing this option will align the south pole of the spherical or cylindrical mapping

primitive with whatever point you select on the model.

Align to North Pole
Choosing this option will align the north pole of the spherical or cylindrical mapping

primitive with whatever point you select on the model.

ElectricImage 2.9 Supplement



New Texture Mapping Features — Negative Z Mapping Improvements

Align to Equator Front

Choosing this option will align the side of the spherical or cylindrical mapping primitive
opposite the seam to whatever point you select on the model.

Align to Equator Seam

Choosing this option will align the seam of the spherical or cylindrical mapping primitive
to whatever point you select on the model.

Option-clicking on the Select Polygons button will enable you to change the picked color
of polygons as you select them in the Texture Info Window.

Improvements to the Texture Mapping “Negative Z” Feature

The Negative-Z feature in texture mapping has been enhanced to provide mapping of a
user-definable ‘volume’ of polygons. Negative Z ON (the default) has always placed the
object completely within the texture.

Disabling Negative Z will yield a texture only from the point of origin to the tip of the
green arrow (the Z value of the texture). This behavior is different from previous versions
of ElectricImage, which would cause the texture to begin at the point of origin and enve-
lope the rest of the object.

This essentially means that you can define a volume of polygons which the texture map
affects. You still have the repeat, hold, and mirror options within this volume.

The effects of Negative Z off are not reflected in the Texture Info window or in the 3D
views. These effects are only seen in output renderings from Camera.
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UV Texture and Shading Coordinates

You might be asking yourself, “what the heck is all this UV stuff about?” Some people
have been under the mistaken impression that Electriclmage doesn’t support UV texture
mapping. If that were true, then whenever you performed a deformation of your model,
the texture applied to your model wouldn't “stick” and would instead slide all over the
place. Well, this doesn’t happen, does it? This problem was solved by our genius technical
wizards many years ago. We never advertised it because in our opinion, any program that
exhibited such obnoxious behavior could only be called “buggy.”

However, there is more to UV coordinates than just making sure that textures stick to
models. Rather than hide the mysteries of UV mapping, version 2.9 of ElectricImage now
exposes them to you, allowing you to take advantage of the power (and the peril!) this fea-
ture has to offer.

Whoa, wait a minute! What’s a U? Or a V?

Ok, ok, simply put, the letters U and V are used by technical types (you know, program-
mers, and “animators who know the C language”) as indicators of the horizontal and ver-
tical directions that a surface patch implicitly contains when you create it. Imagine a
blanket (blue, with a little kid attached, you know the one) as it waves in the breeze (or
flaps like a cape.) Well, when you look at the blanket as a rectangle, the side is one direc-
tion (U), and the top is another (V). Using this coordinate space (there’s that phrase
again) you can imagine a grid running over the blanket, bending and folding with the
blanket as the blanket itself bends and folds.

Well, have you ever created a model in a program, bent or otherwise distorted it, then
brought it into Electriclmage and tried to apply a texture map to it? Not pretty — we
know. You either get weird distortions, or just give up in disgust (or maybe you bought a
plug-in to handle the problem.)
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With direct UV support inside of Electriclmage, you can now position a texture on objects
with UV coordinates and have the texture properly follow the contours of the model,
regardless of how much you mucked with it before hand.

Beware, it is still not common to see modeling programs exporting the UV coordi-
nates, assuming they even use them!

On that same blanket example, you can place wool or cotton maps, coffee stains, lipstick,
or whatever you wish, and have the textures properly react as if they were really a part of
the blanket.

But Doesn’t Electriclmage Render Polygons?

Yep, it sure does, as do all commercially available 3D products. However, many high-end
modeling programs allow you to create your objects with surface patches and solid mod-
eling techniques. These programs, such as the Electricimage Modeler, generate a polygon
mesh from surface and solids data, and pass the UV information to the polygons. If Elec-

tricimage detects this information, it will allow you to use it accordingly.

So, What’s the Catch?

Unfortunately, there is one. You see, surface U and V information typically knows only
about its own surface, not its neighbor’s. Taking that same blanket example, imagine that
instead of being made up of just one rectangular surface patch, it was now made up of 30
different rectangles. What you would now see would be a patchwork of repeated textures
across the entire blanket. As of this time, Electriclmage can only use one UV coordinate

space per group. We will address this limitation in a future version.
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Using UV Coordinates in Electriclmage

The UV feature is found in the Group Info Window/shading tab . To enable this feature,
click on the Use UV Space checkbox. This checkbox will only be visible when an object has
UV coordinates. When UV coordinates are available for the group, this feature defaults to
ON (you can change this if you want to — see the preferences section).

As mentioned above, not all 3D modeling applications export texture vertexes. Elec-
triclmage Modeler does, and several third party Electriclmage plug-ins support UV
coordinates as well.

Using the UV Space Feature

Using UV maps can be a little abstract, as the underlying geometry for the model can be
very complex. Because of this, Electricimage presents a plane which represents the UV
space used by the group. As you position your texture map within the rectangle, your
map will be applied to the model (you can see this effect happen in real time if you have
activated the Display Texture checkbox in the Group Info Window/display tab .)

For the best results with UV mapping, please use the following steps (please refer to the
Electriclmage 2.8 Supplement, page 178 for detailed information on texture mapping
in general) :

* Be sure that the Use UV Space checkbox is on
e Add a texture map

e Activate the texture info window

e Set the Map alignment to Front

e Set the texture view to Front
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You may notice once you have followed these steps that not only does your texture map
properly follow the contours of your object (as if it was actually made out of the map, or
that the map was painted on), but that the map’s aspect ratio is not being maintained. To
correct this, go to the Map Projection Tab and adjust the map scale values so that they
match.

Feel free to experiment with some of the other settings, You can get some rather interest-
ing effects by choosing different map projections (whether or not you find them useful is a
matter of personal taste.)
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Tah Tah for Now — See Ya Real Soon!

Tah Tah for Now

Well, that about does it. Electricimage 2.9 is in the can, and we are all getting ready for the
next one. We hope that you have great success with this version of ElectricImage, and
keep those ideas coming.

Many great people have worked over the last several months to bring this version to you.
Led by Markus Houy (interface) and Mark Granger (rendering engine), and assisted by
Bob Bell, Paul Schneider, Mike Uhlik and Nori Seko of the Framework Development
Group. Jay Roth, Mark Granger and Markus Houy were responsible for application
design, with product development supervision by Matt Hoffman. Internal testing by Peter
Lish and Scott Boyer and general sanity checks provided by Dwight Parscale, Play co-
CEOs Paul Montgomery and Mike Moore and inspiration provided by Kiki “Blaster Space
Chick” Stockhammer, Mark Randall, Daniel Kaye, Steve Hartford, and Stephan Bouchard
(he’s Canadian, eh.)

Many thanks to all of our beta testers across the world, and a tip of the hat to Paul Shersto-
bitoff for the Electricimage 2.9 splash screen (sherstobitof@earthlink.net)
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